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1 Overview 
The new R&S NRP-Z power sensors from Rohde & Schwarz represent 
the latest in power measurement technology. They offer all the 
functionality of conventional power meters, and more, within the small 
housing of a power sensor. The USB interface on an R&S NRP-Z 
sensor enables operation with an R&S NRP power meter, or PC 
running under either Microsoft Windows or Linux.  

R&S Power Viewer Plus1 is an easy-to-use, feature-packed software 
package that offers capabilities beyond those of a regular power meter. 
It simplifies measurement tasks such as power average, timeslot 
average, statistics and trace. In addition, up to four sensors can be 
utilized for measuring average power simultaneously. Results such as 
reflection coefficient or gain can be computed from the measured 
values. 

Particularly the use with a desktop PC makes an R&S NRP-Z sensor an 
ideal and cost-effective solution for lab testing or automated systems. 
The rugged design is suitable for use in the field, such as servicing 
antenna systems. 

If the sensors are to be controlled by a PC rather than using the 
R&S NRP base unit, certain prerequisites must be fulfilled: 

• The PC must provide a USB 1.1 or 2.0 interface 

• The operating system must be either Microsoft Windows XP or 
Linux with kernel 2.6.x 

• The R&S NRP Toolkit package must be installed 

• The Power Viewer Plus software supplied in the R&S NRP 
Toolkit must be installed 

This manual describes the installation and use of the Power Viewer 
Plus software. The application is part of the R&S NRP Toolkit and is 
available free of charge from the Rohde & Schwarz website. 

For the integration of the sensor into custom ATE systems, a versatile 
and powerful VXI PnP driver exists for Microsoft Windows XP- and 
Linux-based systems. Documented coding examples are provided in a 
separate document. 

2 Windows and Linux Version 
Power Viewer Plus is available for Microsoft Windows XP- and Linux-
based systems. Both software packages are available as binary and 
offer the same feature level. For additional information about the 
installation and software prerequisites, please refer to the appropriate 
sections in this document. 

 

1 R&S Power Viewer Plus is referred to as Power Viewer Plus 
throughout this manual. 
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3 Software Installation on Microsoft Windows-Based Systems 
The following section describes the installation process for Power 
Viewer Plus on a Windows XP-based PC. 

Installation of the R&S NRP Toolkit 
The application is part of the R&S NRP Toolkit. Simply select the “R&S 
Power Viewer Plus” option during the toolkit installation process. 

Fig. 3-1 R&S NRP Toolkit Installer 

 

The R&S NRP Toolkit must also be installed if the Power Viewer Plus 
software option is selected. The basic toolkit installation provides all 
basic USB device drivers that are required for operating the sensors. 

Sensor Firmware Requirements 
Power Viewer Plus may require newer firmware versions on certain 
power sensors. Please see the R&S NRP Toolkit documentation for 
more details on updating the sensor firmware. The latest firmware files 
are available free of charge from the Rohde & Schwarz website. 

R&S NRP-Z81   1.16 or later 

R&S NRP-Z5x   4.08 or later 
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Supported Devices 
The following table provides an overview of the supported sensors in 
Power Viewer Plus. 

Sensor 
(R&S) 

USB ID Cont Av Trace Timeslot Statistics 

NRP-Z11 0x000c X X X

NRP-Z21 0x0003 X X X

NRP-Z22 0x0013 X X X

NRP-Z23 0x0014 X X X

NRP-Z24 0x0015 X X X

NRP-Z51 0x0016 X

NRP-Z52 0x0017 X

NRP-Z55 0x0018 X

NRP-Z91 0x0021 X

NRP-Z81 0x0023 X X X X

NRP-Z27 0x002f X

NRP-Z37 0x002d X

NRP-Z28 0x0051 X X X

NRP-Z98 0x0052 X

NRP-Z18 0x001a X

If no sensor is detected, Power Viewer Plus automatically activates a 
simulation mode sensor called R&S NRP-Z00. 

4 Software Installation on Linux-Based Systems 
The application is statically built using the commercial version of QT 4.3 
(www.trolltech.com). There are no dependencies to any external 
libraries. Please see the installation notes bundled with the Linux 
package for further information. 
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5 Known Restrictions 
The VXI PnP driver does not support multiple programs accessing the 
driver simultaneously; only one instance of Power Viewer Plus runs at a 
time. 

At program start, Power Viewer Plus checks if any other instance is 
already running on the system and, if so, pops up a warning message. 

 

Fig. 5-1 Application single instance warning 

 

However, Power Viewer Plus does not detect if any other application 
already accesses the VXI PnP driver. It is therefore advisable to close 
all other R&S NRP-Z-related applications before starting Power Viewer 
Plus. 
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6 Software Features 
Power Viewer Plus simplifies many measurement tasks: 

• Measure average power and view results numerically and as a 
bar chart. 

• View the absolute average power reading or the average power 
relative to a previously set level. 

• Measure the average power of up to four sensors and 
additionally compute results from the measured values. 

• View average power of up to 16 consecutive timeslots as a bar 
chart. 

• Perform statistical CCDF or PDF analysis of envelope power. 

• View the RF power envelope down to a resolution of 5 ns/div; 
measure pulse parameters with markers and within time gates. 

• Forward measurements to the data log module and capture 
results over a period of up to 24 hours. 

Please note that some features depend on the R&S NRP-Z hardware 
used. For example, thermal sensors do not provide statistical signal 
analysis or trace measurements. 

7 Connecting Sensors to a PC 
Please see the manual of your R&S NRP-Z power sensor for 
information on how to put the sensor into operation. Follow these 
instructions precisely to prevent damage to the sensor, particularly if 
you are putting it into operation the first time. 

The following section provides additional information that is related to 
the USB interface or to operating multiple sensors simultaneously. 

 

Multiple Sensors  

If multiple sensors need to be connected to a single computer, check 
that the overall current requirement to operate all sensors is available. 
Each single sensor draws between 300 mA and 500 mA depending on 
the sensor type. 

Example: 

The R&S NRP-Z81 sensor is rated at up to 500 mA supply current. 
Using four sensors simultaneously on one hub requires a total current 
of at least two amperes. Many consumer hubs cannot provide this 
current over a long period of time even if rated for this value. 

For industrial-grade applications, it is advisable to use USB hubs for 
DIN rail mount that can provide up to one ampere per USB port and run 
off a 24 V power supply. The following manufacturers provide such 
devices: 

Beckhoff ( www.beckhoff.com ) CU8005 

Lütze ( www.luetze.de ) 745581 DIOHUB USB 4 

http://www.luetze.de/
http://www.beckhoff.com/
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8 Configuring the Application 
Power Viewer Plus provides a settings dialog that can be accessed by 
selecting Settings -> Configuration from the main menu. 

The dialog is structured using separate tabs for USB communication, 
drawing operations, hardcopies and debug features. 

Timeout-Related Settings 
The Timeout tab is shown below and mainly used for connections 
across USB extenders or USB to LAN interfaces. These devices often 
introduce large turnaround times that need to be taken care of. 

 

The USB communication timeout is internally set to 5 seconds if it is not 
otherwise specified. Connections across the Internet (e.g. using the Digi 
AnywhereUSB® device) may require values of up to 15 seconds. 

Long Distance Connection mode is only available for Windows-based 
operating systems and reduces the number of simultaneous read 
processes. This lowers USB resource allocation in the operation 
systems dramatically. AnywhereUSB® connections, for example, 
require activation of Long Distance Connection mode. 

The measurement timeout is internally used between the time a 
measurement is initiated and the maximum waiting time for a result. 
Normally the internal time of 5 seconds should be sufficient. However, 
very slow connections may make it necessary to increase this time. 
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Drawing Performance 
The drawing performance can be adjusted for slow PCs. Activating 
these features lowers CPU consumption or adds additional idle time. 

Disable transparency lowers CPU consumption by avoiding semi-
transparent drawing operations. Transparent drawing is used, for 
example, for the grid lines in the trace mode because it makes it 
possible to see trace points that fall exactly onto a grid line. 

The number of video points is set to 500 by default. This number 
provides a good compromise between measurement speed and 
resolution. The higher the number of video points, the higher the CPU 
load and acquisition time. On low-performance PCs it may be desirable 
to lower this number. 

The additional video update time adds idle time between two 
measurements. This reduces CPU load and provides resources to other 
applications. The default idle time between two measurements is in the 
order of 100 ms. 
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Hardcopy Features 
Power Viewer Plus creates print reports or copies measurement results 
to the system clipboard. This greatly simplifies documentation tasks. 
Please see section 12 Hardcopy Features for additional details. 

By default the application uses printer-friendly colors when copying data 
to the clipboard. This feature can be turned off by selecting not to invert 
the screen colors. 

The Copy To Clipboard function always creates a bitmap of a fixed size. 
This simplifies documentation tasks, since any display resolution may 
be used and you do not need to specifically rescale captured images. 

Debug Options 
Debug options are for internal use by Rohde & Schwarz and for 
debugging purposes. This field should be left blank unless you are 
instructed otherwise by Rohde & Schwarz. 
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9 The Application Window Layout 
The main application window is divided into three major sections: 

• The measurement windows 

• The settings window 

• The two toolbars 

Only one measurement can be active at a time but it is possible to tile 
multiple measurement windows and switch from one to the other. All 
measurement windows have the same sensor assigned. 

If the settings panel is enabled, it is located on the right side. Its content 
changes with the curr nt window. 

Measurement runni
 

Measurement window

Sensor selection 

ng indicator 
ently activated measureme
Measurement-related settings

Measurement selection
12 Rohde & Schwarz 

Level offset and
correction frequency
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10 Main Menu 

File Menu 
 

File -> Load project settings loads a previously saved configuration. 
Settings affect all measurements and fully restore the state of the entire 
application. 

File -> Save project settings saves the configuration of the entire 
application to a file. The file may later be used to restore a 
measurement configuration. Measurement data is not part of the 
settings file. 

File -> Exit application aborts all running measurements, disconnects 
from the power sensor, and subsequently leaves the application. 

 

Sensor Menu 
 

Sensor -> Read extended sensor information reads all available 
information from the selected sensor. Data returned from the sensor 
can be viewed on the sensor panel and may be used for debugging 
purposes. The sensor panel is automatically activated when this menu 
entry is selected. 

 

Sensor -> Reset sensor initializes the sensor. Any previous zeroing 
remains valid. It is not necessary to reset the sensor before a 
measurement is started because measurements always issue this 
command prior to configuring the sensor. 

 

Sensor -> Zero sensor starts the zero adjustment sequence. For this 
purpose, the test signal must be deactivated or the sensor disconnected 
from the signal source. The sensor automatically detects the presence 
of any significant power to be measured. This causes zeroing to be 
aborted and an error message to be output. 
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This menu always starts a full zeroing sequence that is valid for all 
measurement modes and the full frequency range. The process may 
take up to 8 seconds. 

 

Sensor -> Self test performs a sensor self test and returns the results 
as text message on the sensor panel. The test signal must be 
deactivated before the self test is started. 

 

Sensor -> Scan for sensors starts the process of detecting available 
R&S NRP-Z USB sensors. Activating this menu entry repopulates the 
sensor selection control. If no sensor is detected, a sensor simulation 
(R&S NRP-Z00) will be available. 

Measurement Menu 
 

Measurement -> Start measurement starts a measurement in the 
currently active window. If any other measurement is already running, 
this button is dimmed. Only one measurement window at a time can be 
active and run a measurement. Please note that some sensors may not 
support all measurement modes. In this case, the start button is inactive 
even if the measurement window is selected. 

Measurement -> Stop measurement stops any running measurement, 
even if the associated window is not currently selected. This menu item 
is dimmed if no measurement is running.  

 

All further entries in the measurement menu toggle the state of the 
associated measurement window. If a measurement window is visible, 
the menu item becomes checked. 

The Sensor panel is not directly used for any specific measurement. It 
serves as window for informational or error messages, and provides 
information about the active sensor. 
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Window Menu 
 

Window -> Copy graphics to clipboard sends the content of the 
currently activated measurement (graphics only) to the clipboard. This 
option is only available for measurements that display their result as 
graphics, such as trace, statistics and timeslot. The option is available 
for Windows- and Linux-based systems. 

 

Window -> Print report creates a printout of the currently activated 
measurement. Colors are inverted where necessary to avoid black 
background. This option is only available for measurements that display 
their result as graphics, such as trace, statistics and timeslot. 

 

Window -> Save measurement data saves measurement data from 
the currently active window to a .csv file. The extension stands for 
comma separated value and lists data in columns that are separated by 
a single comma. The option is only available for measurements such as 
trace, statistics or the data log. Comma separated value lists can easily 
be imported in most applications, such as Microsoft Excel or Linux 
Open Office. 

 

Help Menu 
 

Help -> About this software displays program information such as the 
software version and licensing information. 
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11 Toolbars 
The application provides two toolbars. The first one is located at the top 
of the main program window and hosts shortcuts to commonly used 
functions and measurements. The second toolbar is located at the 
lower border and used for sensor selection and general settings. 
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The right toolbar section provides two controls for setting up the 
correction frequency (carrier signal) and an overall level offset. 

 

Both the correction frequency and the level offset value apply to all 
measurement windows.  

This frequency is used for various corrections of the measurement 
result. It is essential that the current carrier frequency is set. Otherwise, 
non-linearities or temperature dependencies considerably greater than 
those stated in the data sheet can occur. 

The offset accounts for external losses. If, for example, a 60 dB 
directional coupler is used to sense power from a DVB-T transmitter, 
this factor can be provided as offset. Power Viewer Plus sets up the 
sensor accordingly and in this case would display power results in KW if 
required. 
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12 Hardcopy Features 
Power Viewer Plus provides two features that greatly simplify 
documentation tasks. With a simple mouse click it is possible to create 
a print report for the trace and statistics measurement as well as the 
data log. Additionally the current graphics can be copied to the system 
clipboard and pasted into any other application. 

Printed Report 
The print button in the toolbar automatically creates a one-page 
measurement report from the current data. Colors are inverted for 
printer friendliness. The picture below shows an example of the 
generated form. 

The printer selection dialog also offers the option to print directly to a 
file, in which case a PDF document is directly created without the use of 
any third-party software. 
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Copy To Clipboard 
The copy to clipboard function creates a bitmap of fixed size from the 
current measurement and subsequently places the bitmap into the 
system clipboard. 

By default colors are inverted and a resolution of 800 x 600 pixels is 
used. If this is not acceptable, these parameters can be changed in the 
settings dialog. 

The figure below shows a captured measurement at a resolution of 640 
x 480 pixels and inverted colors. 
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13 Sensor Panel 
The sensor panel is not directly used for a measurement. Instead, it 
provides additional sensor information and lists text messages, 
warnings and errors that are generated by the application or the USB 
device driver.  

Fig. 13-1 The sensor information panel 

 

The sensor panel is also used to display the output of the extended 
sensor information query. The following information is important for 
debugging purposes: 

- The sensor type 

- The sensor serial number 

- The sensor software build number 

- The FPGA build number 

 

In case of an unexpected program or sensor behavior, it is advisable to 
forward a detailed problem description and the above sensor 
information to the Rohde & Schwarz support center 
(customersupport@rohde-schwarz.com). 

 

mailto:customersupport@rohde-schwarz.com
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14 Alias Name Assignment 
Power Viewer Plus maintains a list of alias names that can be assigned 
to sensors. Each R&S NRP-Z sensor can have an individual name that 
is displayed throughout the application as an additional piece of 
information. 

Sensors that are detected during a scan are indicated by illuminated 
light bulbs whereas unavailable devices appear as gray bulbs. 

If no alias name is known for a detected sensor, only its type and serial 
number is used to identify this device. 

Fig. 14-1 Alias name assignment 

 

The use of alias names simplifies measurement tasks that involve 
multiple sensors. For example, the measurement of an amplifier gain 
requires calculating this figure from the incident and output power. Alias 
names such as “incident” or “output” may be assigned to the sensors 
connected to these signals. This helps to clearly identify a sensor. 
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15 Continuous Average Power Measurements 
In this mode, the average power of the measurement signal is 
asynchronously measured within definable time intervals (sampling 
windows). The width of a sampling window is preset to a length that is 
optimal for the selected sensor but can be changed to other values. The 
measurements are performed with chopper stabilization to obtain more 
accurate results with reduced noise and zero offset. Therefore, a 
measurement is always performed over two sampling windows, the 
polarity of the detector output signal being reversed for the second 
window. By taking the difference of the output signals, the influence of 
the video path on noise and zero drift is minimized. When the averaging 
function is activated, the averaging factor determines how often the 
described measurement cycle is repeated. 

 

Continuous Average Power Settings 

Fig. 15-1 Continuous Average measurement settings 

 

Averaging 

The averaging mode can be set to either "auto" or "manual". In manual 
mode the sensor uses an averaging factor that is set by the user 
between 1 (no averaging) and 65536. In auto mode the sensor 
determines the optimum average filter count internally based on the 
given resolution (0.01 dB). 

Average count 

This is the number of measured values that have to be averaged to 
form the measurement result. The greater this averaging factor, the less 
the measured values fluctuate and the longer the measurement time.  
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Duty cycle correction 

The duty cycle can be set as a percentage when pulse-modulated 
signals are corrected. With the correction activated, the sensor 
calculates pulse power from the duty cycle and average power. 

Measurement window 

The measurement window is the time period that is used to form one 
sample. The Power Viewer Software automatically sets a default 
window that best fits the active sensor. Wider sampling windows may 
be required if the measurement result exhibits fluctuations due to 
modulation. In this case, it is beneficial to set the sampling window 
length to a value equal to the modulation period. 

Correction 

The gamma correction value sets the complex reflection coefficient of 
the source. A magnitude value of zero corresponds to an ideally 
matched source and a value of one to total reflection. The phase angle 
can be set between −360.0 and +360.0 degrees. 

Numerical Data View 
Power Viewer Plus displays average power readings in numerical and 
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Both linear and logarithmic power readings are average measurements 
based on the current average filter setting. If the sensor provides peak 
power data, this number is displayed in the lower left section. 

Please note that peak power readings need to be treated with care 
regarding accuracy. Chopper stabilization or averaging techniques are 
not possible for peak measurements and thus the noise level is 
substantially higher than it is for average measurements. A typical noise 
level for R&S NRP-Z81 sensor peak readings is around −25 dBm. 

 

Relative measurements 

Relative measurements display the current reading relative to a 
previously set reference power level. This measurement mode is useful 
when the measurement task requires the analysis of the stability or drift 
of a power reading. 

If the measurement mode is changed to relative, Power Viewer Plus 
saves the current reading as reference value. Subsequent mode 
changes do not alter this reference power level anymore and a new 
level is set using the ->REF button. 
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Fig. 15-3 Bar graph in relative measurement mode for R&S NRP-Z81 
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16 Statistics 
In the Statistics mode, either the complementary cumulative distribution 
function (CCDF) or the probability density function (PDF) of the 
envelope power can be measured. 

 

Statistics Settings 

Fig. 16-1 Statistics settings 

 

Mode 

Power Viewer Plus supports the absolute and relative CCDF as well as 
the PDF mode. 

The CCDF shows how often a measured power value is above a certain 
level. For this purpose the X coordinate is scaled in dBm and according 
to the absolute power level. The Y coordinate is scaled logarithmically 
and in probabilities from 100 % down to 1e-4 %. 

Samples 

The number of samples determines the length of the evaluation 
window. The overall window length is calculated from the sampling rate 
(80 MHz, 12.5 ns interval) and the sample count. 

The default evaluation length is one million samples. 

The application uses an unsynchronized measurement mode for the 
statistics measurement. Thus, a measurement is started without waiting 
for any trigger event and stopped when the set evaluation period has 
elapsed. 

 

Reference curves 

The current curve can be saved as a reference curve and used for 
comparison with later measurements. Any reference curve data is only 
stored locally in the graphics view. It cannot be saved to a file. 
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The statistics view supports up to four reference curves in addition to 
live measurement data. 

 

Show AWGN reference curve 

This checkbox adds an ideal AWGN curve as reference to the statistics 
data display. The reference curve can be used with all statistics modes. 

Graphical Data View 
The graphical CCDF view may contain the information shown below. 
Level and probability lines are activated with a right mouse click into the 
graphics area. 

Probability line

Average power indicator

Average power 

Probability line values 

Level line values 

Minimum level 
 

Number of curve points

Level line
P

Rohde & Schwarz 

X scaling factor

eak-to-average ratio 
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The application supports the absolute or relative CCDF as well as the 
PDF display. Additionally, the display can be tiled to show a table with 
numeric results on the right side. The table mode is activated using the 
context menu (right click into the graphics area). 

 

In the table mode no numeric data is shown below the graphics to save 
space for the other contents. 

 



PowerViewerPlus.pdf  29 Rohde & Schwarz 

17 Timeslot Average 
In this mode the average power of a definable number (up to 16) of 
successive timeslots within a frame structure with equal spacing is 
measured. 

When the averaging function is activated (averaging factor of two or 
more), measurements are performed with chopper stabilization to 
obtain more accurate results with reduced noise and zero offset. 
Chopper stabilization involves reversing the polarity of the detector 
output signal from frame to frame. By taking the difference of the output 
signals, the effect of the video path on noise and zero drift is minimized. 

Timeslot Average Settings 
The timing section sets all parameters that are required to precisely 
define the timeslot structure of the signal to be analyzed. To obtain 
stable and reliable results, it is essential that these parameters exactly 
match the signal. 

Fig. 17-1 Timing-related settings 

 

Count defines the number of timeslots that belong to a single frame. 
The permissible range is one to 16. 

 

Width sets the width of a single timeslot within the frame structure. 
Each timeslot is of exactly the same width. 

 

Exclude is the time gap at the beginning or at the end of a timeslot that 
is not evaluated for the measurement. This parameter is used to define 
the spacing between adjacent timeslots. 

 

Delay specifies the time between the trigger point and the start of the 
entire frame structure. 

 

The average filter reduces the noise level significantly. The filter count 
sets the number of frames that are to be evaluated to form one 
measurement result. 
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Timeslot average measurements require stable and reliable trigger 
conditions. This is particularly important when average filter techniques 
are used and data from multiple frames is averaged. 

Fig. 17-2 Trigger settings 

 

The trigger source can be either internal or external. If an external 
source is used (R&S NRP-Z3 adapter cable), only the settings for 
polarity and holdoff time are available. 

 

The trigger polarity can be set to either positive or negative. This 
setting is available for all trigger sources. 

 

Level sets the trigger threshold for internal triggering derived from the 
test signal. This setting is irrelevant to all other trigger sources. In order 
to achieve stable trigger conditions, a trigger level above −20 dBm is 
advisable. 

 

Holdoff suppresses trigger events within the set holdoff time (in 
seconds), starting from the time of the last successful triggering. 

 

Dropout is used to set the dropout time in microseconds. With a 
positive (negative) trigger slope, the dropout time is the minimum time 
for which the signal must be below (above) the trigger power level 
before triggering can occur again. As with the holdoff parameter, 
unwanted trigger events can be excluded. The set dropout time only 
affects the internal trigger source. 

The dropout time parameter is useful when dealing with, for example, 
GSM signals with several active slots. When performing a 
measurement in sync with the signal, a trigger event is to be produced 
at A, but not at B or C. As the RF power between the slots is below the 
threshold defined by the trigger level, the trigger hysteresis alone cannot 
prevent triggering at B or at C. This is why the dropout time parameter 
is selected to be greater than the time elapsed between points E and B 
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and between F and C, but less than the time elapsed between G and A. 
This ensures that triggering will take place at A. 

Graphical Data View 
The graphical timeslot average power view contains the information 
shown below. 
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Markers 

Up to four markers can be placed on any of the 16 timeslots for precise 
average power readings. These readings are displayed below the bar 
graph area. 

 

Fig. 17-3 Context menu in timeslot average view 

 

A context menu can be activated within the bar graph view by a right 
mouse click. The menu selects the active marker from one to four. As a 
next step, markers can be dragged by holding the left mouse button 
within the graphics area. A thin line displays the column on which the 
marker is to be placed. 

Moving the mouse to the very left or very right border disables the 
marker. 

 

Logging data 

All marker readings are automatically forwarded to the data log panel 
and appear as individual traces. The data log functionality is always 
active even if the associated window is not visible on the screen. 
Starting a measurement clears all existing data from the data log and 
restarts capturing. 

For additional information regarding the data log feature, please see the 
section 20 The Data Log Panel.
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18 Trace Measurements 
In the Trace mode, the envelope power can be recorded as a function 
of time. This is done by sampling power over a time interval that can be 
specified by the user. The power values are assigned to a number of 
pixels (video points) that each contain data, such as the average power, 
the maximum power and a randomly sampled value. 

When the averaging function is deactivated, measurements are 
performed without chopper stabilization, i.e. a measurement consists of 
a single sampling sequence activated by a trigger event. Otherwise, the 
detector’s output-voltage polarity is reversed automatically for alternate 
sampling sequences. This suppresses low-frequency noise and 
increases the accuracy with which the average power is measured at 
each pixel. Averaging has no effect on the randomly selected samples; 
the largest values for each averaging sequence are output as peak 
values. 

 

Trace Settings 
The Y scale is defined by the two parameters reference level and level 
step per division. Both values can be changed in steps by means of 
plus and minus buttons on the settings panel. In addition, values can be 
entered manually in logarithmic or linear scale. 

Fig. 18-1 Y scale settings 

 

When entering numeric data, both the value and the unit must be 
indicated. The application parses the user entry and converts or 
corrects data as needed. The following units can be used: 

d, dB, dBm  dBm 

k 103

m 10-3 

u 10-6 

n 10-9 

p 10-12 

Reference Level specifies the upper limit of the trace view area. This 
setting only affects the graphical data representation in the application 
and has no influence on the measurement or sensor configuration. 

Y/div sets the scaling of the Y-axis. Zooming is always done by keeping 
the reference level constant and adjusting the lower level accordingly. 

Auto Set tries to adjust Y-scaling, trigger level and timing according to 
the applied signal. All other parameters are set back to defaults. If the 
auto set process fails, all settings are left untouched. 
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Power Viewer Plus uses a fixed grid of 10 divisions for the X axis. The 
time resolution is set per division with the lowest possible value of 
5 ns/div. 

Please note that not all sensors support the same time resolution. 
Additional information can be found in the sensor data sheet. 

 

Fig. 18-2 X-scale settings 

 

The two buttons (plus and minus) increase or decrease the time per 
division value in fixed steps. These steps follow the order 1 -> 2 -> 5 -> 
10 or vice versa. The appropriate unit is automatically added to the 
numeric value. 

 

Fig. 18-3 Averaging 

The Averaging count sets the number of traces to be evaluated to form 
one measurement result. Averaging reduces the noise level of the 
average trace but increases measurement time. Changing the 
averaging count does not have any effect on traces that represent 
random sampling data. A peak trace representation usually increases in 
level slightly with an increase in the averaging count. 

It should also be noted that using trace averaging requires a stable 
trigger event. Otherwise, traces with different timing are averaged and 
the result is erratic. 

 

Fig. 18-4 Trigger settings 

 

The trigger sections defines major trigger parameters such as the 
trigger source, the trigger slope as well as level, holdoff time and 
dropout time. These parameters are to the same as the ones already 
described in the section 17 Timeslot Average.

In contrast to timeslot average mode, the trigger source may also be 
set to free running trigger mode. In this mode a trigger event is 
immediately issued and makes this setting useful for a very first 
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inspection of signals with entirely unknown timing and level. Trace 
averaging cannot be used with free running trigger. 

 

Fig. 18-5 Trace position controls 

 

The trace position sets the trigger point position within the trace view 
area. The arrow buttons move the trace back or forth by one division 
whereas the Center button sets the trigger point to the middle of the 
trace view area (50 %). 

The trace position setting allows the user to view the signal at times 
before the physical trigger point. Please note that this time interval (pre-
trigger) depends on the sensor hardware used. Power Viewer Plus 
automatically corrects invalid ranges for the current sensor. 

 

Fig. 18-6 Trace context menu 

 

The trace graphics view provides a context menu that can be activated 
by a right mouse click. The context menu contains all functions directly 
related to the graphical data representation and does not affect sensor 
settings. 

 

Linear / logarithmic display 

Trace data can be viewed in linear scale (Watts) or logarithmic scale 
(dBm). The menu switches back and forth between these two view 
modes. However, when switching from linear to log mode, negative Y 
values are truncated and the lowest dBm level set to −60 dBm. 

 

Traces 

Some power sensors (R&S NRP-Z81) return data in the form of three 
traces that can be selected with the trace submenu. The average, 
random and peak information is available for each video point of the 
acquired trace data. 

Average power:  

The power values of identical measurement points, i.e. points at the 
same distance from the trigger point, are averaged. This reduces noise, 
the noise reduction being proportional to the square root of the 
averaging factor. 
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Max. values:  

The maximum of all samples taken at identical measurement points, i.e. 
points at the same distance from the trigger point, are found and output. 

Random values:  

The random values are obtained from the first measurement cycle. 
Repetition of the measurement cycle has no effect on the result. 

 

View mode 

The view mode can be set to either normal or envelope mode. In 
envelope mode, trace data is accumulated over up to 200 traces and 
minimum and maximum readings are connected with vertical lines. This 
mode is very useful for analyzing glitches or jittered signals. 

 

Lines 

Fig. 18-7 Measurements related to level lines and time gate 

Time gate and level lines may be activated for simple measurement 
tasks. Both line sets can be dragged by holding the left mouse button. 
Text boxes at the lower border show all related readings such as delta 
values and power readings within the gated area: 

Time Gate 

1 The position of time gate line 1 relative to the trigger position 

2 The position of time gate line 2 relative to the trigger position 

∆ The time difference between both time gate lines 

 

Gated Measurement 

Av The average power between the time gate lines 

Pk The peak power between the time gate lines 

∆ The difference between peak and average power 

 

Level Lines 

1 The level where line 1 is positioned 

2 The level where line 2 is positioned 

∆ The difference between both level lines 
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Markers 

Markers can be tied to trace points for performing automated 
measurements. The context menu is used to activate the Marker 
Settings dialog shown below. 

Fig. 18-8 Marker Settings dialog 

 

Power Viewer Plus offers one reference and up to four delta markers. 

 

Each of the markers can be assigned to the average, random or peak 
trace. This assignment is independent of whether the trace is enabled 
for viewing or not. 

The reference marker is set to a point in time relative to the trigger 
point. Alternatively it may be set to automatic peak tracking mode, 
which positions the marker to the maximum power value within the 
visible trace area. 

 

The reference marker is indicated with a small purple arrow that points 
downward to the set trace.  

 

Delta markers can be defined relative to the reference marker or 
relative to other delta markers. This allows the user to build chains of 
markers and perform measurements between marker points. 

Each delta marker is either set to a fixed point in time relative to the 
marker it depends on, or is used in "N dB down" mode to search for a 
set level. 
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Example of a pulse width measurement 

An automatic pulse width measurement can be performed using three 
markers. The reference marker is set to a fixed point in time where its 
level exactly matches the top pulse power. 

The first delta marker is set to operate relative to the reference marker 
and 3 dB down to the left side. This makes marker one search for the 
point within the rising edge where the 50 % power level is located. 

The second delta marker is set to operate relative to the first delta 
marker. If "N dB down" search to the right side with zero level difference 
is used, the marker searches for the same level on the right side. 

The result is shown in Fig. 18-9 below. 

 

Fig. 18-9 Markers in a pulse width measurement 

 

The pulse width can be read from the ∆T measurement of delta marker 
two. The starting point of the pulse related to the trigger level is 
displayed as ∆T measurement of marker one. 

 

Fig. 18-10 Marker readings 
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Example of a pulse rise time measurement 

The rise or fall time of a pulse can be measured using a set of two delta 
markers and the reference marker. The reference marker is set to a 
fixed point in time where its level exactly matches the top pulse power. 

The first delta marker is set to operate relative to the reference marker 
in 1 dB down mode with search to the left side. 

The second delta marker is set to operate relative to the first delta 
marker. The operating mode needs to be 19 dB down with search to the 
left side. 

The result is shown in Fig. 18-11 below: 

Fig. 18-11 Rise time measurement using markers 

 

The pulse rise time can be read from the ∆T measurement of delta 
marker two. 

 

Fig. 18-12 Marker readings 
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Graphical Trace View 
The graphical trace view contains the information shown below. 
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Fig. 18-13 Trigger level outside of visible area 

 

If the trigger level is outside of the visible area, the green trigger level 
line disappears. Instead, a little arrow next to the T indicates in which 
direction the trigger level is located. 

 

Fig. 18-14 Trigger point outside of visible area 

 

If the trigger point (in time) is located outside of the display area, the 
green arrow rotates and indicates in which direction the physical trigger 
point is located. 

 

Zooming 

Fig. 18-15 Defining the zoom point 

 

The Y zoom mode can be activated by a left click into the trace view 
area. This sets the zoom point, which is marked by two little arrows. 
Subsequently turning the mouse wheel zooms in or out using this point 
as the center position. The following pictures explain the zooming 
process: 
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Step 1: The mouse cursor is positioned at the zoom point, and clicking 
the left mouse button activates the zoom mode. 

Step 2: Turning the mouse wheel away from the user centers the graph 
vertically and zooms in by a factor of two. 

Step 3: Further mouse wheel turns (away from user) magnify the trace 
in increments of two. Turning the wheel back restores the previous 
zoom level. 

Step 4: Clicking the left mouse button again deactivates the zoom mode 
and turns off the zoom point indicator.    

 



PowerViewerPlus.pdf  

 

19 Multichannel Average Power Measurements 
Many power measurement tasks require the simultaneous 
measurement of multiple channels. The Multi Channel measurement 
panel provides up to four parallel power measurements. In addition, four 
results can be computed using mathematical expressions. 
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Multichannel Settings 
Measurement settings are similar to the ones available for the 
continuous power average mode. 

Fig. 19-1 Averaging and duty cycle 

 

The same measurement settings are used for all channels. It is 
therefore advisable to use sensors of the same or similar type for this 
measurement mode. 

 

Channel Assignment 
Power Viewer Plus measures with up to four sensors simultaneously. 
These measurements are referred to as channels A, B, C and D. Each 
channel must be either OFF or assigned to an R&S NRP-Z sensor. An 
additional offset may be set to compensate for individual losses. 

If an alias name was assigned to a sensor, this name is displayed first 
followed by the sensor type and serial number in parentheses.  

Fig. 19-2 Channel assignment 

 

Each sensor can be assigned to an individual power and frequency 
offset. This accounts for individual path losses or measurement 
frequencies within a setup. 
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Mathematical Expressions 
Power Viewer Plus provides a set of most commonly required relations 
that can be computed from two measured values. 

SUM 

Two measured values are added in linear scale and then converted to 
logarithmic scale (dBm). 

 

DIFF 

Two measured values are subtracted from each other in linear scale. 
The result is converted to logarithmic scale (dBm). 

 

RATIO 

Two measured values are subtracted from each other in logarithmic 
scale. The result is displayed in dB. 

 

RCOEFF 

The reflection coefficient is computed from two measurements in 
logarithmic scale using the following equation: 

 

20
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The standing wave ratio is computed from two measurements in 
logarithmic scale using the following equation: 
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20 The Data Log Panel 
The Data Log panel captures up to eight scalar measurements over a 
period of up to 24 hours. A maximum of 10,000 data points is available, 
and each point can represent the average power, minimum and 
maximum power reading within the associated time interval. 

The Data Log panel is always fed from the active measurement and 
therefore any existing data is deleted when a new measurement is 
started. 

The following list shows which data is forwarded to the data log panel. 

 

Measurement  Data     Unit

Cont. Average  Average and peak power  dBm 

Statistics  Average power    dBm 

Timeslot  Marker reading 1/2/3/4   dBm 

Multi Channel  Channel measurement 1/2/3/4  dBm 

Write iTime line 

Y scaling mode 

Time at left border Measurement
 

Time of one video pointndicator
L

Rohde & Schwarz 

evel line Time / division 
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21 Open Source Acknowledgement 
This software makes use of valuable open source software packages. 
The verbatim license texts are provided in the following section. 
 

Package Link License 

Crystal Icons  www.yellowicons.de LGPL V2.1 

Crystal SVG Icons www.kde-look.org LGPL 

 www.everaldo.com

22 Licenses 

GNU Lesser General Public License (LGPL) 2.1 
 

Version 2.1, February 1999  

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 

51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 
 
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other 
authorized party saying it may be distributed under the terms of this Lesser General Public License (also called "this License"). Each licensee 
is addressed as "you".  

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which 
use some of those functions and data) to form executables.  

The "Library", below, refers to any such software library or work which has been distributed under these terms. A "work based on the Library" 
means either the Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either 
verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter, translation is included without 
limitation in the term "modification".)  

"Source code" for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all 
the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and 
installation of the library.  

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running a 
program using the Library is not restricted, and output from such a program is covered only if its contents constitute a work based on the 
Library (independent of the use of the Library in a tool for writing it). Whether that is true depends on what the Library does and what the 
program that uses the Library does.  

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you 
conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices 
that refer to this License and to the absence of any warranty; and distribute a copy of this License along with the Library.  

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.  

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute 
such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:  

• a) The modified work must itself be a software library.  

• b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any 
change.  

• c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.  

http://www.everaldo.com/
http://www.kde-look.org/
http://www.yellowicons.de/
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• d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that 
uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort 
to ensure that, in the event an application does not supply such function or table, the facility still operates, and 
performs whatever part of its purpose remains meaningful.  

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the 
application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be 
optional: if the application does not supply it, the square root function must still compute square roots.)  

These requirements apply to the modified work as a whole. If identifiable sections of that 
work are not derived from the Library, and can be reasonably considered independent 
and separate works in themselves, then this License, and its terms, do not apply to those 
sections when you distribute them as separate works. But when you distribute the same 
sections as part of a whole which is a work based on the Library, the distribution of the 
whole must be on the terms of this License, whose permissions for other licensees 
extend to the entire whole, and thus to each and every part regardless of who wrote it.  

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the 
right to control the distribution of derivative or collective works based on the Library.  

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a volume of 
a storage or distribution medium does not bring the other work under the scope of this License.  

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do 
this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead 
of to this License. (If a newer version than version 2 of the ordinary GNU General Public License has appeared, then you can specify that 
version instead if you wish.) Do not make any other change in these notices.  

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all 
subsequent copies and derivative works made from that copy.  

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.  

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms 
of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable source code, which must be 
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange.  

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source 
code from the same place satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the 
source along with the object code.  

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked 
with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside 
the scope of this License.  

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the Library (because it contains 
portions of the Library), rather than a "work that uses the library". The executable is therefore covered by this License. Section 6 states terms 
for distribution of such executables.  

When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the work may be a 
derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can be linked 
without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.  

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten 
lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables 
containing this object code plus portions of the Library will still fall under Section 6.)  

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6. Any 
executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.  

6. As an exception to the Sections above, you may also combine or link a "work that uses the Library" with the Library to produce a work 
containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit modification of the 
work for the customer's own use and reverse engineering for debugging such modifications.  

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this 
License. You must supply a copy of this License. If the work during execution displays copyright notices, you must include the copyright 
notice for the Library among them, as well as a reference directing the user to the copy of this License. Also, you must do one of these things:  

• a) Accompany the work with the complete corresponding machine-readable source code for the Library including 
whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is 
an executable linked with the Library, with the complete machine-readable "work that uses the Library", as object code 
and/or source code, so that the user can modify the Library and then relink to produce a modified executable 
containing the modified Library. (It is understood that the user who changes the contents of definitions files in the 
Library will not necessarily be able to recompile the application to use the modified definitions.)  
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• b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at 
run time a copy of the library already present on the user's computer system, rather than copying library functions into 
the executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long as 
the modified version is interface-compatible with the version that the work was made with.  

• c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified 
in Subsection 6a, above, for a charge no more than the cost of performing this distribution.  

• d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to 
copy the above specified materials from the same place.  

• e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.  

For an executable, the required form of the "work that uses the Library" must include any data and utility programs needed for reproducing the 
executable from it. However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in 
either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.  

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the 
operating system. Such a contradiction means you cannot use both them and the Library together in an executable that you distribute.  

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not 
covered by this License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and 
of the other library facilities is otherwise permitted, and provided that you do these two things:  

• a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other 
library facilities. This must be distributed under the terms of the Sections above.  

• b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and 
explaining where to find the accompanying uncombined form of the same work.  

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt 
otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this 
License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as 
such parties remain in full compliance.  

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or 
distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or 
distributing the Library (or any work based on the Library), you indicate your acceptance of this License to do so, and all its terms and 
conditions for copying, distributing or modifying the Library or works based on it.  

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original 
licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions 
on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties with this License.  

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), 
conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not 
excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and 
any other pertinent obligations, then as a consequence you may not distribute the Library at all. For example, if a patent license would not 
permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through you, then the only way you could 
satisfy both it and this License would be to refrain entirely from distribution of the Library.  

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to 
apply, and the section as a whole is intended to apply in other circumstances.  

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such 
claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is implemented by public 
license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on 
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other 
system and a licensee cannot impose that choice.  

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.  

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original 
copyright holder who places the Library under this License may add an explicit geographical distribution limitation excluding those countries, 
so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if 
written in the body of this License.  

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new 
versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.  

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it and "any 
later version", you have the option of following the terms and conditions either of that version or of any later version published by the Free 
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Software Foundation. If the Library does not specify a license version number, you may choose any version ever published by the Free 
Software Foundation.  

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to 
the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; 
we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally.  

NO WARRANTY 

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR 
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE 
LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.  

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, 
OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO 
YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING 
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO 
OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.  

 

23 Our Hotline 
If you have any questions or suggestions, please contact our hotline: 

Telephone: +49 (0) 180 512 42 42 

Fax:  +49 (0) 89 41 29 637 78 

E-mail:  CustomerSupport@rohde-schwarz.com 
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